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MUC TIEU CUA CHUYEN DE

\
e CO kién thirc vé Ky nang viét
e Hiéu dwoc tam quan trong clia Ky nang viét

:
« C6 k¥ nang viét bao cao thwe tap ctia minh.
 Trinh bay bao cao rd rang, hiéu qua

|« CO thai do tich cwe, chuan bj tot cho ky nang
viét
 Can than, tap trung.




) CACH TRINH BAY CHUYEN DE THU'C TAP TOT NGHIEP
/"'”"rm-m»cr““fji

» Bai bao cao cudi cung dwoc sap xép theo thi tw sau:
» Trang bia chinh

» Trang bia phu

» Trang “L&i cam on”

» Trang “Nhan xét cta giang vién huwédng dan”

» Trang “Danh muc cac tir viét tat”

» Trang “Muc luc”

» Trang “Danh muc bang”

» Trang “Danh muc hinh”

» Phan ndi dung cliia chuyén dé thwc tap tot nghiép.
» Phan “Phu luc”

» Tailiéu tham khao



THIET LAP TRANG WORD

S S T

M¢& trang Word méi  S&r dung MS Word

= Menu Page Layout - Page setup - Size 2>
Chon A4 - Margin

= Top: 2,5cm; Bottom:2,5cm; Left: 3,5cm;
Right: 2,5cm; Header: 1,5cm; Footer: 1,5cm.

2 Dinh dang c& giay

= Menu Page Layout
3 Chon spacing = Cach dong (line spacing): 1,5 lines
= Cach doan (spacing): Before: 6 pt; After: 6 pt

= Tao Folder THUCTAPTOTNGHIEP
4 Luwufile = Nén /tru FILE WORD theo cu phap:
2016.12.04.baocaoTTTN_nguyenvananh.doc



TAO SECTION, TAO SO TRANG

Section 1: (khdng danh sé trang)
=Trang bia chinh
*Trang bia phu
Section 2: (danh sé trang theo i,ii, ...)
*Trang “L&i cam on”
=Trang “Nhan xét ca giadng vién hwdng dan”
=Trang “Danh muc c4c tt viét tat”
=Trang “Muc luc”
1 Tao sections  sTrang “Danh muc bang”
=Trang “Danh muc hinh”
Section 3: (danh s6trang 1, 2, 3, ...)
=Phan ndi dung ctia chuy@n dé thwc tap tét nghiép.
=Phan “Phu luc”
=Tai liéu tham khao
Chon Page Layout -> Breaks -> Next Page dé tach van ban thanh 2 section
khac nhau: 1 section tt vj tri con trd chudt dén hét van ban va 1 section tr dau
dén hét cac trang khong chira con tré chuét.

= Lacong viéc kho (Insert -> Page numbers -> Format page
numbers.)

» (tham khdo hwéng dén: http://thuthuatphanmem.vn/cach-danh-so-trang-trong-
word-tu-dau-hoac-trang-bat-ky/)

2 Panh sé trang




DINH DANG CHUYEN DE THU'C TAP TOT NGHIEP

» Panh so trang:

0 Céac muc trwde phan “ndi dung chinh”; danh sb thi tw trang theo kiéu i, ii, ...
o Tw phan “ndi dung chinh”: danh sé th tw trang theo kiéu 1, 2, 3...

» Panh so cac phan, muc: nén danh theo sdarap (1, 2, 3,
), khong danh theo s6 La Ma (I, 11, 11, ...) va chi danh sO
t0| da 3 cap theo qui dinh sau:
0 Tén Phan: dinh dang theo tiéu dé cap 1 (heading 1)

» Vidu:

PHAN 2: LY THUYET

o Dé muc cap 2: dinh dang theo tiéu dé cap 2 (heading 2), bat dau tir s6 the tw
cda Phan:

vidu: 2.1 Co’ s@ ly luan
o D& muc cap 3: dinh dang theo tiéu dé cap 3 (heading 3)
Vidu: 2.1.1 Quy dinh cua phap luat
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TRUONG DAI HQC MO TP. HO CHI MINH TRUONG DAI HQC MG TP. HO CHi MINH
KHOA KINH TE VA LUAT KHOA KINH TE VA LUAT

Fant Times New So=an
Siee L7, i= ddm, carn gilra

Ein chinh

ngodi cing

Font Times Sew So=an
Siew L7, 1= ddm, carn gilra

Fant Times Sew Sa=an
Siee L7, i= ddm, carn gidra

NGUYEN VAN A _NGUYENVANA
MSSV: 1054060123 MSSV: 1054060123

[TEN BE TAI SINH VIEN THUC HIEN] [TEN DE TAI SINH VIEN THU'C HIEN]

Fant Times Yew da=an

Fant Times Sew Lo=an
Siee 24, i+ ddm, carn gidra

Size 24, i= d3m, carn gira

CHUYEN DE THU'C TAP TOT NGHIEP

NCANH LUAT KINH TE CHUYEN BE THUC TAP TOT NGHIEP
’ NGANH LUAT KINH TE

Fert Times hiw Romas
S 1&. in £3mM.canh gika

Fert Times hew Romas
L 13.ind4m . canh gida

NGU'OI HUONG DAN KHOA HQC

Font Times dew da=an
Size L5, i= ddm, carn girra

Fert Times hew Romas
Sae 14, in 49m. canh gia

Fant Times Sew So<an
fize 15, i= ddm, carn gira

Thanh phi Hd Chi Minh - Nim 2014

Thanh phii H Chi Minh - Nim 2014




LO1 CAM ON, NHAN XET

» L& cAm on can ngan gon, suc tich, tranh sao réng.
» Nhan xét: thwc hién theo quy dinh cua Khoa



DANH MUC TU VIET TAT

STT TU VIET TAT DIEN GIAI

1 ATLD An toan lao dong

2 ND Nghi dinh

3 TCVN Tiéu chuan Viét Nam

4 TNCN Thu nhap ca nhan

S} TPHCM Thanh phé H6 Chi Minh
6 TTg Tha twéng

7 UBND Uy ban Nhan dan

8 XHCN Xa hdi Chu nghia



MUC LUC

» St dung muc luc tw déng.
» Muc luc c6 03 cap (Level 1, 2,3)

» Hwong dan céach tao tw ddong. Cach thwc hién
http://thuthuat.taimienphi.vn/tao-muc-luc-tu-dong-
trong-word-2010-2234n.aspx

» C6 thé tao trwd'c hodc sau khi soan van ban.

* Thue hién truée thi st dung cira s6 Style & menu
home hodc str dung menu References dé tao.

* Thure hién sau: xem giang vién huéng dan.
St dung ctra s6 quén Iy muc luc (Menu View ->
Document map).




/ MUC LUC (tiép theo)

» Chen trang muc luc vao bao cao
Pé chudt dau trang can chen.

St dung References = Table of contents, néu mudn cép

nhét s6 trang mé&i nhat thi st dung tién ich update.
potrences D

=5 e T addText- 1 [T ag ) )
o— 2 __ul Update Table of Contents

.........................................................................
POIME S 2 S S S o R S L

Select one of the following options:

mmmmmmmmm

) Update page numbers only
g R R I Update entire table

mememe Cancel | (D

AN 3 o e e 4
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RIS i e e A

=% Gustom Table of Contents...
= Remove Table of Contents




TOM TAT PHAN 1
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Biét mét bao cao gom nhirng phan nao?
Thiét 1ap dwoc trang Word

Biét 1ap section va danh sob trang

Biét ké khung va lam bia chinh, bia phu.
Biét lam muc luc tw dong.

Hiéu vé cach lwu triv.

vV Vv v VvV V9v v



DINH DANG CHUYEN DE THU'C TAP TOT NGHIEP

» Font style:

O O O o o

Tiéu dé cap 1 (heading 1): viét hoa, in dam, canh gilra

Tiéu dé cap 2 (heading 2): viét thwérng, in dam, canh trai

Tiéu dé cap 3 (heading 3): viét thworng, in dam, canh trai

Van ban (body text): viét thwong, canh justified

Tén bang, biéu, so' do...: viet thwong, in dam, canh gitra phia trén
bang, biéu so do.

Pon vi tinh: 7 viét thwong, in nghiéng, nam phia trén va bén
phai cua bang, biéu hay hinh

Nguodn: viét thwong, in nghiéng, nam phia duwoi va bén tréi clia bang,
bieu hay hinh



CAC QUY BINH bOI VOl BANG, BIEU, DO THI, HINH

Khi 1ap bang, biéu, dé thi, hinh sinh vién can lwu y cac diém sau
day:

»Phai danh so theo tirng loai va bao gom luon so thir tw cua
Phan

Vidu: Hinh 1.1, Hinh 1.2, ...

(Trong dé: s6 1 dau tién 1a so thir tw cda Phan 1, s0 1,2, ... tiép
theo la so ther fwr hinh trong Phan do)

Bang 1.1, Bang 1.2, ...

(Trong d6: s6 1 dau tién 1a so thir tw cda Phan 1, s0 1,2, ... tiép
theo la so ther tir bang trong Phan do)

»Phai c6 tén

Vi du: Bang 1.1: SO liéu chi tra thu nhap cta ngwei lao dong
nam 2011
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CAC QUY BINH bOI VOl BANG, BIEU, DO THI, HINH

Phai c6 don vi tinh

Vi du: PVT: tridu dong
Phai c6 nguén
Vi du: Ngubn: Béo céo két qué hoat dong cua doanh

nghiép nam 2011.

S0 phéi dugc phan cach hang ngan bang dau Cham (.) va
phan cach dau thap phan bang dau phay (,).

Vi du: 1.007.845,25

S6 phéi dwoc canh phai, khdng canh gitra va khdng canh trai
S0 trong cling mét bang, biéu hay do thi phai cé cling so
Iuio’ng sO thap phan. Tuc I‘é néu lay 2 sérthép phan thi toan b6
sO trong cung mo6t bang déu phai co 2 s6 thap phan.

Khéng nén dé mét bang, so d6 cling nhw tén va ngudn cla
bang, bieu; d6 nam-¢&-hai trang. - Co6-gang-dé cung- ¢ -mot-trang.
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CACH TAO DANH MUC BANG, BIEU, PO THI, HINH

» St dung Tao new Label (Bang; Hinh;...)

» Khi thiét 1ap bang thi der chudét noi can lam ->menu
References - Insert Captions - 6 Label chon “bang”

» Lwu y hiéu chinh lai font chi¥, kich thuwéece ...
» Twong tw cho hinh.

» Tao bang danh muc bang hoac hinh twong tw muc luc nhwng
th hién badi chirc nang Insert Table of Figures.



QUI BINH VE CACH VIET TAI LIEU THAM KHAO

Liét ké cac tai liéu da dwoc ngwoi viét thwe sy tham khao
dé thwc hién dé tai nghién cutru.

CA&c tai liéu tham khao phai dwoc sap xép theo th ty
abc theo HO cua tac gia.

Néu séach (b&ao) co 2 hay 3 tac gia, liét ké tat ca tén cla
tat ca tac gia.

Néu sach (b&o) coé ti 4 tac gia trd Ién, liét ké tén mot tac
gia va nhirng ngu¢i khac ghi chung la “cac tac gia”.

Lwu y: Chi viét ho va tén tac gia khong ghi hoc ham, hoc
vi, chtre danh cua tac gia.




QUI BINH VE CACH VIET TAI LIEU THAM KHAO

Tat ca cac tai lieu tham khao phai dwoc ghi theo dung cau trdc nhw
sau:

Sach:

»Ho va tén tac gia (nam xuat ban), Tén sach, nha xuat ban, noi xuat
ban.

»Vidu:

»Nguyén Thi Thay & Nguyé&n Thj Thu Hién (2010) Ludt Ngan sach nha
nwoce, NXB Thanh nién.

Mot chwong trong mét cuon sach:

»Ho va tén tac gid (n&m xuat ban), “Tén chuong”, Tén sach, nha xuéat
ban, noi xuat ban.

»Vidu:

»Nong Quoc Binh (2010), “Chuong 1: Mét s6 van dé li luan ve luat
thwong mai quoc té”, Giao trinh Luéat thwong mai qudc té, Nha Xuat
Ban Céng an Nhan dan, Ha Noi.



QUI BINH VE CACH VIET TAI LIEU THAM KHAO

Tat ca cac tai lieu tham khao phai dwoc ghi theo dung cau trdc nhw
sau:

Tap chi

»Ho va tén tac gid (thang ndm xuat ban), “Tén bai bao”, Tén tap chi, s6
tap chi, trang cua bai bao.

Vi du:

»Wi Théqh Long (Thang 8/2012), “Tréch nhiém lién d&i trong tra lai te‘a,i
san va bdi thwdng thiét hai ngoai hgp dong”, Phap luat & Dan Chu, S6
245, tr. 29.

Bao

»Ho va tén tac giad (ngay thang ndm xuat ban), “Tén bai bao”, Tén béo,
trang cua bai bao.

Vi du:

»Lé Van T (06/9/2012), “Tien sk dung dat va vai tro lich st cta n6”,
Kinh té Sai Gon, tr.20.



QUI BINH VE CACH VIET TAI LIEU THAM KHAO

Téat ca cac tai liéu tham khao phai dwoc ghi theo dung céu triic nhw sau:
Bai bao trén Internet

»Ho va tén tac gid (ngay thang nam xuat ban), “Tén bai bao”, Tén bao,
dwoc download (hoac truy cap) tai dwdng link..., ngay download (hoac
truy cap).

»VWi du:
»Wan Giang (21/6/2012), “Kién doi n¢g bao hiém xa hoi”, Tudbi tré Online,

dwoc download tai dia chi hitp://tuoitre.vn/Chinh-tri-Xa-hoi/497917/Kien-
doi-no-bao-hiem-xa-hoi.html vao ngay 22/7/2012.

Néu tai liéu 14 van ban phap luat

»Can ghi dung ky hiéu van ban phéap luat qui dinh tai B.7 Luat ban hanh
van ban qui pham phap luat ngay 03 thang 6 nam 2008.

»Wi du:

»Nghi dinh s6 72/2006/NB/CP ngay 25 thang 7 ndm 2006 quy dinh chi tiet
thi hanh Luat thwong mai vé van phong dai dién, chi nhanh cua thwong
nhan nwdc ngoai tai Viét Nam.




QUI BINH VE CACH VIET TAI LIEU THAM KHAO

Tat ca cac tai liéu tham khao phai dwoc ghi theo dung cau tric
nhuw sau:

Néu tai liéu 1a ban an
»Can ghi dung ky hiéu ban an va trich yéu theo hwéng dan tai
Nghi quyét s6 01/NQ-TANDTC ngay 31 thang 3 nam 2005.
Vi du:
»Ban an s6 09/2005/KDTM-ST vé: “V/v tranh chap vé hop dong
thué mua tai chinh” cua Tdéa an Nhan dan tinh A.

»Sinh vién st dung Chu dan (footnote) dat & cudi trang (trén
Microsoft Office Word, vao IQsert/reference/footnote... sty
dung bottom of page dé chu dan).



QUI BINH VE TRIiCH DAN

Tat ca cac tai liéu tham khao phai dwoc ghi theo dung cau tric
nhuw sau:

Néu tai liéu 1a ban an

»Can ghi dung ky hiéu ban an va trich yéu theo hwéng dan tai
Nghi quyét s6 01/NQ-TANDTC ngay 31 thang 3 nam 2005.

Vi du:

»Ban an s6 09/2005/KDTM-ST vé: “V/v tranh chap vé hop dong
thué mua tai chinh” cua Tdéa an Nhan dan tinh A.

»Sinh vién st dung Chu dan (footnote) dat & cudi trang (trén
Microsoft Office Word, vao IQsert/reference/footnote... Sty
dung bottom of page dé chu dan).



QUI BINH VE TRIiCH DAN

» Viét lai y ciia mét tac gia:

Trong trwong hop nay, sinh vién dung y cua mét ngwoi nao do
nhwng dién dat lai bang 101 cia minh. Khi dé, sinh vién van
phai trich dan day du thong tin nhw huwéng dan cach viét tai
liéu tham khao, so trang (néu cd) c6 chira y do cua tac gia.

» Chép lai y cua tac gia khac

Trong trwdng hop nay, sinh vién chép toan bd (hay gé}n nhw
toan bd) y cua mét tac gia khac thi sinh vién phai dé phan
chép do trong dau ngoac kép “..." va ngay sau do phai trich
dan day da thong tin nhu huéng dan cach viét tai liéu tham
khao, sb trang (néu c0) co chira y do cua tac gia.

» Lwuy: Tat ca c'éc trwwdng hop trich dan trong bai viét phai
dwoc ghi chi tiet & muc tai liéu tham khao.
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PHAN NOI DUNG CHINH

Cach Lui dau dong.
»Heading 1 thi canh gitra.
yHeading 2 dé ngay bia trai.

»Heading 3: Lui vao phai 5cm. Khoang cach gilra Numbering v&i cau
thwong la 1cm.

»Doan van, First line I0i vao 1cm, Indentation Right va Left dé & “0”.
Ké bang:

»Str dung insert Table.

»M6t bang phai dwoc canh gitra va gidn déu hét tir trai sang phai.
yHang trén cung (chd dé) cia bang nén in ddm va dé mau xam nhat.
»Néu c6 hang téng cong thi in dam.

Chen hinh:

»Khdng nén chén hinh anh nhwng dé ché do in front of text, nén dé In
line with text.



TOM TAT PHAN 2

» Nam dwoc cach trich dan, tai liéu tham khao.
» Biét chon font, kich thuwdc chir

» Biét dan trang, khodng cach phu hop,

» Biét 1ap danh muc bang, hinh,

» Biét ké bang, thiét 1ap bang, hinh trong word.



// Nhirng diém sai thwéng hay gap

»Quén canh déu hai bén van ban;
»St dung nhiéu font chi;

»In nghiéng, bd ngoac kép tuy tién;
»Dé dau ... (ba cham) tuy tién;
»Str dung ngbn ngir noi;

»Ngat cau, ngat doan tuy tién;



TRUNG TAM HUONG NGHIEP - TU VAN VIEC LAM
Phong 009 - 97 V8 Van Tan - Phwdng 6 - Quan 3 - Tp.HCM

CHUC CAC BAN THANH CONG

Qﬂ ﬁt 9‘ Rt



